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Doc-To-Help Quick Tour

This mini self-paced tutorial will show you how easy it is to create a project in Doc-To-Help, as well as build your
output, apply styles, create links, and more. You will build a project about Pittsburgh using two existing documents. This
Quick Tour uses Microsoft® Word as the document editor, but the same principles apply when you are using Doc-To-

Help's built-in XHTML editor or an HTML editor.

As you are working through this Quick Tour, you may want to =I_earn more about the features discussed — if so, please
refer to the Dynamic Help window, or click the Help button ' to open Doc-To-Help online Help.

@ Watch the video: Starting a New Project in Doc-To-Help (3:21)
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Welcome to
Doc-To-Help
2012!

Doc-To-Help 2012 is a single
source authoring tool that makes it
possible to write once and publish

many different deliverables.

Technical communicators, Help

authors, policy writers, and other

content creators can author any

type of information in Microsoft

Word, HTML, or XML, and publish to

the Web, Help systems, or printed
manuals. It is the perfect choice for
creating many types of user

assistance (compiled HTML Help, =

m
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http://helpcentral.componentone.com/videos/D2H2010_Tour/StartingANewProject.html

Let's get started ...
Creating a new project is quick and easy with the Getting Started Wizard.

This wizard opens when you open Doc-To-Help. It can also be used to open an existing project, open a sample project (a

great way to test drive a Word, HTML, or XHTML project), or convert an older existing project to a Doc-To-Help
Project.

=

. Getting Started With Doc-To-Help

What Would You Like to Do?

- s

Once you hav t

crea

€L L
target outputs as you

7

@ a Start a New Project

Create a brand new project. You can have Doc-To-Help create new files, or you
can import your own Word, HTML, or XHTML files.

Open an Existing Project
= Browse projects you have already created.

Open a Sample Project

et Open one of our pre-assembled projects.

) Convert an Existing Help Project to a Doc-To-Help Project
: Convert a RoboHelp, HTML Help, WinHelp, or Doc-To-Help 2000 project.

Resources
ComponentOne Video Library &3 Guided Tour 8% Free Introductory Webcasts
@ Help . Doc-To-Help \Web Site z Training Information
|| Show this wizard at startup [ Next > ] Cancel

Choose Start a New Project and click Next.

Note: If you have closed the Wizard, click the Getting Started Wizard button in the upper right to reopen it.

Home Topics Project

@
é; 2 é,ol @] Target Template - ¥ New = (57 Platforms: - & o n
=5 @ " o Cancel Build - y ‘_':"IJ Source Template ™ LA Q L (%)
. . sy Target CSS ™ 4 Add @Targets: e = . ”
Select | Build Rebuild View = = an o Share Synchronize Translate Work
G‘ Build Log . s Source CS5
Target ~ - - Theme " xj Remove E Attributes: @ Offline
Target - Pittsburgh 250 HTML Help ] Target Design Source - Documents\Pittsburgh250References.doc = SharePoint® Documents
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s "

_ New Project Wizard ==
Name Your Project
Project Mame

Mew Project

Location

Ch\Users\nickyb\Documents\My Doc-To-Help Projects\MNew Project

Doc-To-Help will create a project directory for you. To specify a different one, click the Browse button,

Avoid locations that already contain a Doc-Te-Help project file (.d2h).

< Back | [ Mext = l | Cancel
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Name your project Pittsburgh. Doc-To-Help will automatically name the project location folder with the same name.

Note that Doc-To-Help saves your project in the default My Doc-To-Help Projects folder. This makes it easy to keep
your projects organized.

(You can change the default folder if you wish, just click the File tab > Doc-To-Help Options button. Choose the Files
button.)

I )

. Mew Project Wizard @
Name Your Project

Project Mame

Pittsburgh

Location

C:\Users\nickyb\Documents{My Doc-To-Help Projects\Pittsburgh

Doc-To-Help will create a project directory for you. To specify a different one, click the Browse button.

Avoid locations that already contain a Doc-Te-Help project file (.d2h).

< Back | [ Mext = l | Cancel

Click Next.
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The next screen will give you the opportunity to import settings from an existing project. Since we are going to work

through a few settings later, we will skip this screen.

e

- Mew Project Wizard

Import Settings From an Existing Project

check box below and choose the project file using the Browse button.,

Import settings from this project:

If you would like to import settings (styles, output settings, variables, etc.) frorm another project, select the

-

==

< Back | [

Mext > l | Cancel

Click Next.

Getting Started Workbook
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Now, you can select the default language for your project. By default, it is U.S. English, but you can choose another

from the drop-down.

Doc-To-Help will choose the correct character set based on the language chosen.

i

- Mew Project Wizard

Select the Default Language

easily readable,

Select the main (default) character set you'd like to use for this project. You will be able to use other
characters too, but selecting the appropriate main language can make your files smaller in size and more

-

==

English {United States)

< Back | [ Mext = l | Cancel

Click Next.
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Doc-To-Help uses templates and style sheets to determine how content will look and behave in both your Source
documents (when authoring in Word, Doc-To-Help's built-in XHTML editor, or an HTML editor) and your final Targets
— the online Help and printed manual outputs.

Now you can use the wizard to select the style sheet (.css) for your HTML or XHTML Source documents and the
template (.dot) file for your Microsoft® Word Source documents.

Doc-To-Help will automatically choose your Target style sheet and template based on your selections.

. Leave the default setting of Full set of styles.
. Leave the default setting of Normal 8-1/2"" x 11" Template (no left indent).
- Mew Project Wizard @

Select the Default Source Style Sets

Doc-To-Help automatically attaches a Microsoft® Word termnplate or a style sheet to your project’s
documents. You can change them later or use your own.

Select style sheet type:

s
w Full set of styles -

This style sheet will be used for your HTML and XHTML documents.

Select document template:

m)= Mormal 8.5" x11" Template (no left indent) -

This ternplate will be used for your Microsoft® Word documents.

Learn more about styles

< Back | [ Mext = l | Cancel

Click Next.
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Now, select your default Help target. You can generate any of these targets from your project at any time, but the default
chosen here will be the one displayed when you open your project. Choose NetHelp (Doc-To-Help's browser-based
uncompiled HTML format). This output can be used on the web, within a software application, or on a file server.

s "

0 Mew Project Wizard @

Select the Default Target

& Targetis a Doc-To-Help output, Choose the default Target for your project below,

You can select and build any Target once wour project is created; wour default choice is effective only until
wou choose another,

S HTML Help 1x

&5 JavaHelp

L Microsoft Help 2.0
'@'Micmsnﬁ: Help Wiewer Lx
! MetHelp

= Printed kanual

& iinHelp 4.0

= Eclipse Help

=5 Maohile Help

Learn more about targets

+ Back | [ Mt = ] | Cancel

Click Next.
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Now you select the type of document you'd like your first document to be. Choose Import existing files — because we
are going to use an existing document to start our project.

Doc-To-Help will launch another Wizard after the project is created that makes it easy to import an existing document.

i )

_ MNew Project Wizard ==

Select Source Content Type

In Doc-Te-Help, you author and edit your content in Doc-Te-Help's editor CXHTML), Microsoft® Word, or
HTML editors. This screen allows you to choose how you would like to start your project. Doc-To-Help will
create the initial files of your choice, you can import your existing files, or you can start with an empty
project.

) XHTML document

Project will include a new XHTML document.

1 Microsoft® Word document

Project will include a new Microsoft® Word document.

1 HTML document

Project will include a new HTML docurnent.

@ Import existing files

Import existing Word, HTML or XHTML files into this project. An import wizard will appear after the
project is created.

(") Empty project, no initial document

Ma initial documents will be created.

< Back | [ Mext = l | Cancel

Click Next.

Getting Started Workbook Doc-To-Help Quick Tour e 9



That's it! Review the new project information and click Finish.

s "

_ New Project Wizard ==

Confirm Settings and Create Project

Project File Name: ChUsers\nickyb\Documents\My Doc-To-Help Projects\Pittsburgh®Pit...
Source Style Sheet: Full set of styles

Source Document Termnplate: Mormal 85" 211" Template (no left indent)

Default Help Target: MetHelp

Initial Document Type: Imported documents

Werify the settings abowe, then click Finish to create your new project. If you have selected the "Import
existing files" option, an import wizard will appear after you click Finish,

< Back | [ Finish l | Cancel

10 e Doc-To-Help Quick Tour Getting Started Workbook



Our project is created, but since we chose the Import existing files option, the Document Import Wizard will open.

s "

- Document Import Wizard @

Choose Document Location

ﬂ @ Local

-
Import documents stored on your computer or the network,

SharePoint®
Import documents stored in a SharePoint Library.

Mext = l | Cancel

Choose Local and click Next.

Getting Started Workbook Doc-To-Help Quick Tour e 11



-

w!' Document Import Wizard

Choose the Type of Document to Import

W _
. \ @ Microsoft® Word ((doc or .docx)

.5
@ () HTML (.htrm or Jhtml)

9 B,
(70 XHTML (eml)

Mext =

|

Cancel

Choose Microsoft® Word and click Next.

12 e Doc-To-Help Quick Tour
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"~ "

w!' Document Import Wizard

g

Choose an Import Option

Doc-To-Help allows you to work in Microsoft® Word or convert the file(s) to XHTML for editing in the
built-in editor,

@ Keep my content in Word

Your files will be added to the project and you can continue working in Word.

) Convert to XHTML

Doc-Te Help will convert your Word file(s) to XHTML so that you can work with them in
Doc-Teo-Help's editor,

< Back | [ Mext = l | Cancel

Choose Keep my content in Word and click Next.
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Now click the Add file(s) button to select the file. The file you need is named PittsburghQuickTour.doc.

The Select Files for Import dialog box will automatically open to the My Doc-To-Help Projects folder.
PittsburghQuickTour.doc can be found in \Samples\Pittsburgh250WordSource\Documents.

.l Document Import Wizard | &= |

Select Files or Folders to Import

Doc-To-Help will import all files and folders added below.

Add file(s)...

-

. MSSandcastle
. Pittsburgh250HTMLSource
. Pittsburgh250WordSource

B Glossary.doc
B pittsburgh250References.doc

Ll Select files for import =]
@i\z’l'| J « Samples » Pittsburgh250WordSource » Documents v|¢,|| Search Documents o
Organize New folder =~ O ':@'
] _ ! My Doc-To-Help Projects Documents library .
@ Copy files to: Documents Arrange by: Folder ~
. Samples Documents
() Leave files at their original location . EmployeeHandbook
MName

. C55Files 1] pittsburgh250WordSource.doc
. Documents E IIE_I] PittsburghQuickTour.doc I
, Media 8] pittsburghRichContentVariables.doc
. MNetHelp
[ , Temp

- 4 L

File name: PittsburghQuickTour.doc

- ’Word documents (*.doc*.docx, v]

] |

’ Open Cancel ]

Click the Open button in the Select files for import dialog box. PittsburghQuickTour.doc will display in the Wizard.

Please note that Doc-To-Help will automatically copy this file into the appropriate folder;
folder.

your project's Documents

14 e Doc-To-Help Quick Tour
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"~ "

w!' Document Import Wizard @
Select Files or Folders to Import
Doc-To-Help will import all files and folders added below.
----- JEI_] PittsburghQuickTour.doc

[ Add file(s)... ]

| Addfolder.. |
@ Copy files to: Documents E
() Leawve files at their original location

< Back | [ Import ] | Cancel

Click Import and the document will be imported.

Getting Started Workbook Doc-To-Help Quick Tour e 15



"~ "

w!' Document Import Wizard

g

Import completed

@ The documents have been successfully imported.

Close

Click Close. The imported document displays in the Documents pane. The Documents pane is "Home base" in Doc-
To-Help.

16 e Doc-To-Help Quick Tour Getting Started Workbook



DIhEE g o G- ComponentOne Doc-To-Help - Pittsburgh.d2h ‘

Home Topics Project
: 3 QJTargetTemplate' “j Mew = [ Platforms: T
ﬁ @ % é@l @ Cancel Build @J Source T

an . :
Select | Build Rebuild View 5 g iig (o G Target €55 [3Add @ Tergets S Source C
P g e . Cs3 Source
Target - - - Theme b zj Remove E Attributes: S
Target - NetHelp T Target Design Source - Documnents\PittsburghQuickTour.doc
Documents 7} StartPage | 3| Topics |
'ﬂ :'] cj' _;- @ = X |+ > ¢
BT ) PittsburghQuickTour.doc Welcome to DOC Help
Common Tasks
! G @
A P T P o PRy ‘_.-*-“‘*'d-\. r , - T .

As noted earlier, our document was automatically added to the appropriate folder in the Doc-To-Help Pittsburgh project
folder. Word source documents are stored in the Documents folder of the project.

4 | My Documents
4 | My Doc-To-Help Projects
4 | Pittsburgh
., C55Files
./ Documents
. Media

From the Documents pane, double-click on PittsburghQuickTour.doc to open it. In Microsoft® Word, take a look at
the Doc-To-Help ribbon (it will be a toolbar in pre-2007 versions of Word). With it, you can create links, add index
entries, and more. Doc-To-Help uses this information to create the final Targets.

Doc-To-Help

ﬁ g@ d l‘ 2‘ "3 Ni‘ = Q g2 IE = v ﬁ %j (% 8 Collapsible section =

4, Clear Formatting =

[®) Flash Movie & j 2]
[ABC| [ABC)

[ HTML Help Contral

.

Add Rename Delete 1 2 3 4 Body Link Inline Keyword Group Link Topic  Conditional Variable Margin  Image . Add Sort About
Text Text Tag Properties  Text A Apply Style ~ Note - Map Editor [ft] Cross-reference - Terms
Tapic Headings D2HMIL Styles £l Links Glossary Help

Now it’s time to learn more about specific Doc-To-Help features. Although the lessons below are divided up to make
them more manageable, it is recommended that you do them in order so that you can see the progression of your project.

Getting Started Workbook Doc-To-Help Quick Tour e 17



Building and Examining a Target

So far, we've done very little, but we've given Doc-To-Help enough to work with. If we build right now, we can take a
look at what Doc-To-Help will do out-of-the-box — but first, let’s take a quick look at our Word document. If it is not
already open, double-click on PittsburghQuickTour.doc to open it.

It is structured like this:

Heading 1 — Pittsburgh's 250" Anniversary
Heading 1 — Pittsburgh Sports

Heading 2 — Football

Heading 2 — Baseball

Heading 2 — Hockey

Heading 1 — Pittsburgh Sites

Doc-To-Help will use this structure to create topics, the table of contents, and automatic links.

Close PittsburghQuickTour.doc and click the Build button in Doc-To-Help. The default NetHelp Target (chosen
earlier) will be built.

ﬁ Home Topics Project
i}- @ % éd &) Cancel Build

Select | Build |Rebuild View ¢ Build Log
Target ~ - o

Target - NetHelp

Doc-To-Help will prompt you to view the Target. Click Yes.

ComponentOne Doc-To-Help [3m]

@
l@' Would you like to view the help target that has just been built?

[] Don't show me this again Yes l I Mo

(Your browser’s security settings may block display of NetHelp. Click “Allow blocked content” to view your Target.)

18 e Doc-To-Help Quick Tour Getting Started Workbook



Take a look at the Target first:

The Table of Contents structure is based on the Heading styles (since "Football”, "Baseball", and "Hockey"
were Heading 2s under the Heading 1 of "Pittsburgh Sports", they were converted to subtopics).

Click on the "Pittsburgh Sports" topic in the Table of Contents. The Topic has three automatic subtopic links —
"Football”, "Baseball", and "Hockey" — which were created by Doc-To-Help based on the document structure.
We'll learn later how to add custom subtopics, but these are created automatically.

(@ Pittsburgh Sports | | Mo ~ [ g v Page= Safety~ Tools~ @~

- Pittsburgh

Contents Index Search - |°| o | | EL| 8 | @

O Pittsburgh’s 250th Anniversary

| Pittsburgh Sports |

B Footoall Pittsburgh Sports

[y Baseball . _ . .

& Hockey Pittsburgh is well-known for its professional sports teams, and has been
[ Pittsburgh Sites hailed as the "City of Champions” because two teams (the Pittsburgh

i4  Steelers and Pittsburgh Pirates) won their league's world championships in
the same year (1979). The Pittsburgh Penguins have also won the Stanley
Cup three times (1991, 1992, and 2009).

More:

“ Football
“ Baseball
“ Hockey

Now a quick look at Doc-To-Help:

Click the Contents pane button. The Table of Contents is displayed. In this pane, you can rearrange the TOC
any way you want, and add/delete topics, but the automatically generated Table of Contents is logical, and can
be used as-is if you like. Note that the Table of Contents in the Contents pane looks exactly like the Table of
Contents in the NetHelp Target.

Click the Topics window tab. Each Heading 1 and Heading 2 is a separate Topic in the project. This will make
it possible to create links between topics and more.

Contents 8 srrege )/ 5 oupur V3] topics x |
: EI @ ¥ § ¥ iﬂ@ﬂ)ﬁ.@ I—I'I'itle Style
@ Pittsburgh's 250th Anniversary o
oAy Pittsburgh Sparts Documentsh... Pittsburgh's 250th Anniversary Heading 1
~|@ Football Documentsh... Pittsburgh Sports Heading 1
] Baseball Documentsh... Football Heading 2
@ Hockey & .
_[@ Pittsburgh Sites Documentsh... Baseball Heading 2
Documentsh... Hockey Heading 2
Documentsh... Pittsburgh Sites Heading 1
|ID Documents
.ﬂ Contents

Now that we've seen our baseline, let's add more to this project.

Getting Started Workbook Doc-To-Help Quick Tour e 19



Inserting a Graphic

First, the graphic we need must be moved into our project. Using Windows Explorer, navigate to WMy Doc-To-Help
Projects\Samples\Pittsburgh250WordSource\Media. Copy Pittsburgh_Confluence.jpg. Drop it into the WMy Doc-To-
Help Projects\Pittsburgh\Media folder. (Although you can use images from any folder, it is a good best practice to store
all of your images in your project's Media folder.)

Just a reminder, the My Doc-To-Help Projects folder can be found here:
. Windows® 7 and Vista: \\Users\<username>\Documents\My Doc-To-Help Projects

. Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects

e

@Uv| b Libraries » Documents |k My Documents » MWy Doc-To-Help Projects » Pittshurgh » Media

File Edit Wiew Tools Help

Organize = Share with - Burn Mew folder

Documents library

= Libraries Media
3 Docurments

| MWy Documents

My Doc-To-Help Projects | Pittshurgh_Confluence jpg

m

Marme

Now we are ready to insert our graphic. If it is not already open, double-click on PittsburghQuickTour.doc in the
Documents pane to open it.

Add a new line after the third paragraph (it begins with “The Center of Pittsburgh...”). In the Insert ribbon, click the
Picture button to open the Insert Picture dialog box. Choose Pittsburgh_Confluence.jpg and click the Insert drop-
down. Choose Insert and Link. This is the recommended option for Doc-To-Help projects.

20 e Doc-To-Help Quick Tour Getting Started Workbook



Pittsburgh250WordSource.doc [Compatibility Mode] - Microsoft Word

References Mailings Review View Developer Muance PDF Doc-To-Help @
Cover Page ~ E ElE @ Shapes ~ % Hyperlink E Header - @ Cuick Parts - L& Signature Line ~ TT Equation ~
|1 Blank Page ¥ & Bookmark | Footer - 4‘ WordArt - % Date & Time £2 Symbol -
= Table —
'% Page Break - ") Cross-reference |#] Page Number - Box~ 2= Drop Cap -~ '§d Object -
Pages Tables Links Header & Footer Text

Search Media

Organize = Mew folder =+ [ @
i, Microsoft Office Word @ Documents library , . ¢~
Media
7 Favorites Name
B Desktop =
8. Downloads I \#| Pittsburgh_Confluencejpg | 3

P itt‘” “Zl Recent Places
. Ji Music
B Desktop
= Libraries
@ Documents
] My Documents
. Public Documents
J' Music

[&= Pictures

The city of
Inhonoroft

Rl e r—

> [ Al Pictures (“emf;"wmf"jpg ~|

The center of]|
and Alleghen |

File name: Pittsburgh_Cenfluence.jpg

Tools ~4 I Insert H ’ Cancel ]

Pittsburgh is {|
is no longer ay Insert
e, edcaE Link to File
sportsteams.

. . . . . ) . Insertand Link
Also known as “The City of Bndges,” Pittsburgh has 446 vehicle, pedestran, and railroad bnidges, more - -
city in the world ] Shawl’i;lewous versions

The graphic is now inserted in the document.

Getting Started Workbook
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Oa) H9-0 PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word i = Bl ¢

A e

Home ’Insert' Page Layout References Mailings Review View  Developer Doc-To-Help Format @

2 — " El@l L Shapes ~ =] Header - |Z] Quick Parts ~ |2~ | TL Equation -
. vl ] 2

T2 SmartArt 5| Footer ~ A wordat > 51 || {2 symbol -
Pages | Table Picture Cli Links Text =
S = A,f il Chart 5 [#] Page Number ~ || gox~ ASDropCap~ ’gd~ |
Tables Illustrations || Header & Footer Text Symbols |

Fl

Pittsburgh’s 250" Anniversaryf|

The city of Pittsburgh, Pennsylvania celebratedits 250 anniversary in 20087

Inhonor ofthat occasion, here is a guide to what makes Pittsburgh a great placeto live, work, and visit.§

The center of Pittsburgh is the often-photographed confluence — the spot where the Monongahela and Allegheny rivers
meet to form the Ohio.

Page:1 of 3 | Words: 478 | English (United States) | e

\

By the way, you can quickly add a Flash movie to your project using the Flash Movie button on the Doc-To-Help
ribbon tab. Check out DemoWorks (http://www.componentone.com/SuperProducts/DemoWorks/) if you need a software
tool to create movies.

}‘ | Doc-To-Help |

4 N — - =" iE Collapsible Section | U= 5 | [®) Flash Movie

$ et (= 7 =

x ] '% Clear Formatting - |§) HTML Help Control
% Link Inline Keyword Group Link Topic  Conditional Variable Margin  Image -

f; Text Tag Properties Text #A Apply Style ~ Note * Map Editor ] Cross-reference ~
i DZHML Styles A Links
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Applying a Style

Doc-To-Help uses styles to markup your source documents. In Word, these styles are in stored in a template (.dot or
.dotx) file. The source styles are interpreted by the Target template to make the target files look and behave the way you
desire. For example, as you saw earlier, Heading 1 and Heading 2 styles will determine your project's topic list, the
structure of your Table of Contents and the automatic subtopic links.

In this section, you will learn how to apply a Doc-To-Help style in Word. Although the style we will apply in this
exercise is one that only controls formatting, later we will apply styles that control both formatting and behavior (see
Adding Glossary Entries on page 39).

If you were using Doc-To-Help's XHTML editor, you would apply styles using the Style List window, which is also
very easy to use.

When using Microsoft Word as your editor, you can apply styles quickly using the Home and Doc-To-Help ribbon tabs.

{Eﬂ;\ =, LI Pittsburgh250WordScurce.doc [Compatibility Mode] - Microsoft Weord - = X
| *Ej
) Insert Page Layout References Mailings Review View L7]
=5 X || Arial M RIIE = ||EE 5 % % A
o heE B Z U ~abe x, x°||&] ]| =
Paste = - =T Quick Change | Editing
. F - A Aa||A & -2 9T Styles~ Styles~ || -
Clipboard ™ Font F} Paragraph (] Styles P}
EE' Styles * X
Heading 1 T
Heading 1 + Su
Heading 2 T
Heading 3 n
Heading 4 T
' 's 250" Anni
Pittsburgh’s NNIV | Heading 5 v
Heading 6 1T|l|
Heading Base bl
Index Base T _
The city of Pittsburgh, Penmsylvania is celebrating its 230th anniversary m 2008, Show Preview
Inhonorofthat occasion, here is a guide to what makes Pittsburgh a great placeto b [ Disable Linked Styles
The center of Pittshursh is the often photosraphed confluence — the snot where the * Options. ..
m T
Page:1of10 | Words: 1,425 | English (United States) | 3] ‘EEEREET e 0 (+)
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Let's add some new text to PittsburghQuickTour.doc. After “Pittsburgh has over 80 different neighborhoods,” add:
South Side (home of a mix of restaurants and live music venues)
Station Square (home of the Gateway Clipper)

Select the text and click the Styles dialog box launcher on the Home ribbon tab. The Styles box will open. (In Word
2003, from the Format menu, choose Styles and Formatting. The Styles and Formatting box will open.)

Choose the C1H Bullet style. The style is applied.

P

’@ H9-0 s PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word S — B ¢
~ Home | Insert Page Layout References Mailings Review View Developer Doc-To-Help @
(<51 4 Times New Roman 110 ~||[= = A// % Y
1y (B 7 U ke % |E
Paste o - e | T . Ty o Quick Change Editing
% 7 |a§;, A' Aa~||A A7 '.@' == 'l;ﬁlﬁ“ﬂ‘ Styles ~ Styles ~ ¢
| Clipboard ™ Font F] Paragraph P Styles 7
lhe center of Fittsburgh 1s the often-photographed contluence — the SPOGEI Styles v x
meet to formthe Ohio. §
C1 Section Collapsed . 45
C1 Section End T 1:‘
C1 Section Expanded I
¢ C1H Bullet T
o ClHBullet2 T
o CIlHBullet2A T
C1H Conditional a
Pittsburgh is the second-largest city in Pennsylvania and was once know: C1H Contents Title a
is no longer atthe heart of Pittsburgh’s economy. Pittsburgh is now a hig
care, education, technology. and financial services industries. C1H Context ID a
Pittsburgh has over 80 different neighborhoods. including:
South Side (home of a mix ofrestaurants and live music venues.
" . Show Preview
Station Square (home ofthe Gateway Clipper 2
o y Clipper] &z [ pisable Linked Styles
e  Oakland (home ofthe University of Pittsburgh and Camegie M« ™~
e 1]]1 = s B . Options...

Page:1 0f3 | Words:19/497 | English (United States) | 3 |

\
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Open the Doc-To-Help ribbon tab, you’ll see that it includes the Heading 1, 2, 3, 4 and Body Text buttons so you can

apply those styles quickly.

RPN A

+3

o

Link

e,

"] 2] ['3] [4]

Headings

e

»
=
=

Text

e

Inline Keyword Group

Ya e ook

Link
Tag

Doc-To-Help

Collapsible Section

Clear Formatting

Topic  Conditional Wariable
Properties Text A Apply Style -
D2HMIL Styles ]

Creating a Topic Link

In PittsburghQuickTour.doc, go to the “North Shore” bullet and select the phrase "Pittsburgh Pirates" in the text, then
click the Link button on the Doc-To-Help ribbon tab. The Link dialog box will open.

f?\i MCD -

PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word

= =] &2

Home Insert Page Layout References Mailings

@ B el E @ E l =1

Add  Rename Delete Body Link
Text

Topic Headings I

Review

)
+3

Inline Keyword Group

Text

Wiew

Doc-To-Help @

[
]

Link Topic Co
Tag Properties

D2HMIL Styles

3

P

Pittsburgh has over 80 different neighborhoods, meluding:

s  South Side (home of a mix ofrestaurants andlive music venues)

»  Station Square (home ofthe Gateway Clipper)

¢+  Oakland (home ofthe University ofPittsburgh and Camegie Mellon University)
s  North Shore (home of the and Pittsburgh Steelers)

» Shd . Link

Text: Pittsburgh Pirates

i)

Link type: I Topic title -l

Target

Topic: Baseball

Topics

A|Dﬂ¢:u'le|'l

Topic
'
(Defined by Text)

IBasebaII

Documents\PittsburghQuickTour.doc

Football

Link options

Window: (Default)

[C] Popup

Documnents\PittsburghQuickTour.doc

Options
Hide properties in document
[ Show as butten

@ Help
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Take a quick look at the Link dialog box. Note that you can also create links to Keywords (AKA index entries),
Groups, Bookmarks, Link tags, and Glossary entries. Simply click on the Link type drop-down. Also note that in the
Options area, you can select the Show as Button check box. This will change your link text to a button. Selecting the
Popup check box in the Link options will make the topic display in a popup window. By the way, linking will work in
the PDF version of your manual target, as well as your Help targets.

Handy Hint: You can select a Grid or Tree view of the "link to" topics. Click the button to the right to choose.

ok ||| =)
Text: Pittsburgh Pirates

Link type: | [5] Topic title ~ V-

Target j Topic in Document
Topic: ﬁ Topic title
¥ Linktag
Topics .
A Bookmark in Document
Tooi
PE . 7 Keyword [ B
' =
[ Group
(Defined ’E.E Gl e
Baseball ==-proeamentsh Pittsburgh250Word Source.doc

Now that you have learned more about the Link dialog box — in the Topics tab, expand PittsburghQuickTour.doc (if
necessary) and choose Baseball from the list. When you click OK, you will create a topic link from the phrase
"Pittsburgh Pirates™ to the topic about baseball.

If you have hidden text turned “on” in your document, you will see the information for this link tag displayed. As you
can see, the “tag” is the Topic you selected (“baseball”).

s + Oakland{homeofthe University- of Pittsburgh-and Camegie Mellon- University )
s —+ MNorth 8hore-(home-ofthe Pittsburgh-

If you would like to hide hidden text — in Word 2007 and 2010, choose the Office button (or File tab) > Word
Options, and click Display on the left. Clear the Hidden Text check box on the right. In Word 2003 and earlier, choose
Tools > Options. In the View tab, Formatting Marks section, clear the Hidden Text check box and click OK.
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Creating Inline Text

Inline text is expanding, drop-down, or popup text. It's a great way to add dynamic information to your Help project.

In PittsburghQuickTour.doc, select the phrase "250th Anniversary" from the first sentence and click the Inline Text
button. Choose the Expand text inline radio button, and add text (Its semiquincentennial!) in the text box.

0q) ld 9 - v -
i
Home Insert Page Layout References Mailings Review View Developer Doc-To-Help | &
J J J J =1 Sy = W
= s | 3
Add Rename Delete Body Link JInline Keyword Group Link Topic  Conditional -
Text Text Tag Properties Text
Topic Headings DZHMIL Styles

The city of Pittsburgh, Pennsvlvama celehrateditslliDTh anmv ersar}'lj.n 20089

s

Inhonorofthat occasion, here is .
. Inline text

The center of Pittsburgh is the off
meet to form the Ohio. 7 Selection:  250th anniversary

Text

Its semiguincentennial!

Opticns

Pittsburgh’s 250" Anniversaryf i

@ Expand text inline

~ Dropdown text [7] Text in comment

~ Show text in a popup ¥

Page:1 of 3 Words: 2/499 | Englis _ [

® Help OK l [ Cancel —

Click OK. Doc-To-Help will inform you that this is an invisible style (this means the inline text we added will be
invisible in this document (our Source document) — as well as in our Target until clicked). Since that is OK, click No to
close the message box. When we build the Target, “250th Anniversary" will be a hyperlink that will display "Its
semiquincentennial!" when clicked. Save and close the document, build, and take a look if you would like.

Getting Started Workbook Doc-To-Help Quick Tour e 27



Creating an Index Entry

You can add index keywords (also known as K-Links) right from your document. You can also do this in Doc-To-Help,

which will be demonstrated later.

Select the word "Monongahela” in PittsburghQuickTour.doc (it's in the 3" paragraph) and click the Keyword button
on the Doc-To-Help ribbon. Click OK to add “Monongahela” to your index.

“Monongahela” will display in your source document with a different text color, but that color change will not be visible

in your final Targets. It is there in your source so that you can see it.

,.f.‘;?@ H9-u -

Home Insert Page Layout References Mailings

@l @ o) (1) 2] [3) (4] 5| [ 52
i 2 3 4

Add Rename Delete EBody

Link

Review

Inline

¥

Keyword

_ e

View Developer Doc-To-Help ':@

=Y g ®

Group  Link Topic  Conditional '

Text Text Tag Properties Text
Topic Headings D2HML Styles
The city of Pittsburgh, Pennsylvania celebratedits 230th anniversary in 20089 Ca
Inhonorofthat occasion, here iz a puide to what makes Pittsburgh a great place to live, work, andvisit.
The center of Pittsburgh is the often-photographed confluence — the spot where r.hell\vf[nnongahela Imd Allegheny nivers
. Keyword =
Text: Monongahela Dynamic Help »
LRI A (K eyword defined by Tesxt) '\l ﬂ B | 2

Keywords

% Add New Keyword 7 Add Secondary Keyword

Pittsl Options
iz o) Hide properties in document
care
Yisible
Pitts]

Wl @ Closehelp

Page: 1 d

i

Inserting an
Index Entry

You can assign and

add keywords {index
entries or K-links) to

your documents using
D2HML. -

m | &

QK l ’ Cancel
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When you look in the Index and Groups pane of Doc-To-Help, Monongahela will be there.

Keywords

BlE= (2 2 (% 3= X
! Monongahela

| Meonongahela: One Topic Indexed

1 [LLJ

------ o Pittsburgh's 250th Anniversary (Pittsburgh Q)

You can add additional keyword and secondary keywords from this dialog box. See Adding Items to the Index and

Creating Groups on page 42.

Let's build our target now and take a look at it. First, save and close PittsburghQuickTour.doc. Click the Build Target
button e in Doc-To-Help. After the build is complete, view the Target. See Building and Examining a Target on page

18 for more information.

The project will open in your browser.

ugp'mshmgh 1 v [ fwh v Pagev Safetyv Tools~ @@~

Contents Index Search -

| Pittsburgh's 250th Anniversary |
@ Pittsburgh Sports

[0 Foatball

0 Baseball

[ Hockey
0 Pittsburgh Sites

©0 2 as L

2 th 2
Pittsburgh’s 250™ Anniversary
The city of Pittsburgh, Pennsylvania recently celebrated its 250th
anniversary.

In honor of that occasion, here is a guide to what makes Pittsburgh a
great place to live, work, and visit.

The center of Pittsburgh is the often-photographed confluence — the spot
where the Monongahela and Allegheny rivers meet to form the Ohio.

LI 3

Done

M Computer | Protected Mode: Off iy v H10% v r
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Click on "Pittsburgh's 250th Anniversary" in the table of contents. You'll see that:

e "250th Anniversary" is a hyperlink that will display text (Its semiquincentennial!) when clicked.

e "Monongahela™ is not highlighted in the Target (but it is included in the Index — click the Index button above
the Table of Contents).

e The first two bullet points (about the South Side and Station Square) are properly formatted.

e "Pittsburgh Pirates” is a hyperlink that opens the "Baseball" topic.

You will also notice that the project name appears in the header as ""Pittsburgh — the name we gave the .D2H project
in the wizard. We will change that in the next step using the Help Targets dialog box.

Defining Help Targets

By default, our sample has ten default Help Targets. Using the Help Targets dialog box in Doc-To-Help, we can rename
our targets and delete the ones we don't need.

First, click the Targets ribbon group dialog box launcher to open the Help Targets dialog box.

Qg9 o .j &= ComponentOne Doc-To-Help - Pittsburgh.d2h = = =
E Home Topics Project Lp ':9:‘
3 @_J Target Template ~ j New = (53 Platforms: v =N
iz?\' @ % éCJ la Cancel Build | . @ ll\FEIJSourceTem;:llate‘ = O*m ' )
Select | Build Rebuild View | =3 p o Elaei L4 Add [t | > Share Synchronize Translate Work
& Build Log . K tss Source C55
Target - - - [=] Theme ~ & ] Remove [F] Attributes: = Offline
Target - NetHelp D Target Design Source - Documents\PittsburghQuickTour.doc SharePoint® Documents
Help Targets
Documents MR ==
EEE AT -
docl R [ = X (@ Add New Target ~ X Remove Target = Basic i
) PittsburghQuickTour.doc 2= Eclipse Help Yo NetHelp
¢ EPUB
(& Help2.0 Base name: L
% HTML Help 1
&, JavaHelp Style sheet: [HTML.CSS vl
£ Manual Template: [ctH HTMLDOT -
Mobile Help
MS Help Viewer Theme: [(Defauty -
@ WinHelp MNetHelp 2.0 Target
Attributes: (none) -
Folder: NetHelp G
= Localization
Locale: [IUEE - English (United States) 'l
CodePage: (65001 - Unicode (UTF-8) -
Charset: utf-8 -
(= Background
5, Color:
__J Documents 3 Gl l:l
___u Contents Image file: E]
_Lfl Index and Groups k=2
@ Help [ oK I I Cancel ]

' [5)8] Related Topics
[ Ready

]

Since NetHelp is our default Target, that is the option displayed first. Let's change the Name field from "NetHelp" to
"Pittsburgh's 250th Anniversary NetHelp."

As soon as you click in the window on the left, the hame of the project will change in that list.
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Also enter "Pittsburgh's 250th Anniversary" in the Caption field. This will change the name displayed in the browser

from "Pittsburgh” to the name we prefer.

. Help Targets @
(&) Add New Target ~ X Remove Target o Basic il
-~ Eclipse Help Name: Pittsburgh's 250th Anniversary MetHelp I
..¢ EPUB =
_a) Help 2.0 Base name:
[ HTML Help 1
-k JavaHelp Style sheet: [HTML.css v]
-2 Manual Template: [cLH_HTMLDOT -
----_3 Mohile Help
Theme: [Tab; v]
Q Pittsburgh's 250th Anniversary NetHelp
WﬂHelp e NetHelponarget
el L o st R Ty py S M‘*‘"“W“"“ PR m-.._....
e i i e e [ LN S ,.‘,_7,_/—"\-'\-'\"_' el T I T M
= Advanced
Caption: Pittsburgh's 250th Anniversary I
@ Help oK ] I Cancel ]

Click on the HTML Help (compiled HTML Help) Target on the left. Rename it also.

Do the same with the Manual Target. While you are there, scroll down and change the "Title" to "Pittsburgh @ 250,”
the "SuperTitle" to "Visitors Guide,” and the "By Line" to "Pittsburgh Productions."

Since we don't need to create Help 2.0, JavaHelp, MS Help Viewer, Eclipse Help, or WinHelp for this project, click on
those Targets in the window on the left and click the Remove Target button for each. (You can always add them back

later.) Click OK.

Now, click the Select Target button. The newly named Targets are displayed, instead of the defaults.

!EL 6@} % éd -PuhllshtnSharePc

Build Rebuild View @ Cancel Build
’ v <7 Build Log

& Pittsburgh's 250th Anniversary EPUB

? Pittsburgh's 250th Anniversary HTML Help
i Pittsburgh's 250th Anniversary Manual

Topics Project

=5 Pittsburgh's 250th Anniversary Mobile Help
€) Pittsburgh's 250th Anniversary NetHelp

If you'd like, save and close your documents. Select each Target, then build and view the Targets. You will see the
changes we made displayed in each Target.

Please note: you can have several versions of the same Target. For example, you could have multiple NetHelp Targets
directed at different audiences. Just add them using the Add New Target button in the Help Targets dialog box.
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Creating Custom Topic Relations

As we discussed earlier, when you open your NetHelp Target and click on the "Pittsburgh Sports" topic in the Table of
Contents, you will notice that at the bottom of the topic, there is a section that begins with "More:," followed by links to
"Football," "Baseball," and "Hockey." These are called Subtopic Links and they are created automatically by Doc-To-
Help, based on the structure of your document.

Pittsburgh Sports

Pittsburgh is well-known for its professional sports teams, and has been
hailed as the "City of Champions” because two teams (the Pittsburgh
Steelers and Pittsburgh Pirates) won their league's world championships in
the same year {1979). The Pittsburgh Penguins have also won the Stanley
Cup three times {1991, 1992, and 2009].

More:

< Football
< Baseball
“ Hockey

"Pittsburgh Sports" is a Heading 1, and "Football," "Baseball,” and "Hockey" are Heading 2's immediately following it
in PittsburghQuickTour.doc. If there were Heading 3's under "Football” they would appear as Subtopic Links in that
topic.

By default, the word "More" appears before the Subtopic links, but you can change that. Open the Help Targets dialog
box for your Help Target and change it in the Label field.

You can change it for individual topics by selecting a Topic in the Topics window and changing the Related Links
Label in the Topics ribbon.

iiﬁ Horme Topics Project
| § J?] I#F_ @ 6% 1 Platforms: ~ | | Related Links Label:

Printand Filter | Contents Index Related @Targets: . More:
Export~ WView - Topics E Attributes: | | ] Hide subtopic links
View Condition Related Topics

It is easy to add your own custom topic relations using the Related Topics pane.

Open the Related Topics pane and choose Pittsburgh Sports from the list. You'll see that "Football" "Baseball" and
"Hockey" are displayed in the pane below automatically. Select Pittsburgh Sites from the Topics window and drag it
into the lower Related Topics pane. It is now related (it is marked as a Custom related topic).
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g e fals ComponentOne Doc-To-Help - Pittsburgh.d2h = =3

Iaﬂ Home Topics Project | 12 @

Ii] Platforms: | Related Links Label: : !'1"'
@ - | e ::.‘. 6=
55 - = ore Properties | Open
Attributes: = | [ Hide subtopic links
View | Condition | Related Topics | Properties | Editor |
Related Topics
2% [OlE 0 &

------ ﬁ Pittsburgh's 250th Anniversary
El @ Pittsburgh Sports
¢ 3| Football
Baseball

Pittsburgh's 250th Anniversary Heading 1

Heading 1

Pittsburgh Sports

=] Hockey Football Heading 2
""" 2] Pittsburgh Sites Baseball Heading 2
Hockey Heading 2

». &4 | 4 Related Topics
= a@ Custom related topics

: ------ . Pittsburgh Sites (PittsburghQ
El 7 Subtopics

------ . Football (PittsburghQuickTour.doc)
Baseball (PittsburghQuickTour.doc)
------ . Hockey (PittsburghQuickTour.doc)

Pittsburgh Sites Heading 1

EkTour.dg

@ Index and Groups
Related Topics

Ready [ .2

L -

Save and close your documents, then click the Rebuild Target button and build your project.

m Home Topics Project
. @ % 6CJ @ Cancel Build

Select Emld Rebuild | View @?Emld Log
Target - - -

Target - Pittsburgh's 250th Anniversary NetHelp
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Look at the new list of subtopic links for Pittsburgh Sports. “Pittsburgh Sites” has been added to the list.

Pittsburgh Sports

Pittsburgh is well-known for its professional sports teams, and has been
hailed as the "City of Champions” because two teams (the Pittsburgh
Steelers and Pittsburgh Pirates) won their league’s world championships in
the same year (1979). The Pittsburgh Penguins have also won the Stanley

Cup three times {1991, 1992, and 2009].

More:
“ Pittsburgh Sites
=+ Football
% Baseball
“ Hockey

If you would prefer the subtopic links are not displayed in a specific topic, choose that topic in the Topics window and
select the Hide Subtopic Links check box from the Topics tab.

Iaﬂ Home Topics Project
Platforms: | Related Links Label: = \‘q:,
Flog @ o

Print and Filter | Contents Index Related @Targets: . More: Properties | Open
Export~ View - Topics E Attributes: < I|:| Hide subtopic links I
View Condition Related Topics Properties | Editor

As you can see, automatic and custom topic relations give you a lot of options for navigating your Help project.

For example:
e You can create custom links to other topics that users may find useful — and the links are very clear and
noticeable.

e You can create custom links from subtopics to their "parent" topics — this directs the user back to the parent,
which may lead them to other topics of interest.

e Relating topics eliminates information "deadends™ — the user has links to other information and could be saved
the trouble of using search, or checking the TOC or index.
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Adding a Document

On occasion, you might need to add an existing document to your project after you've created it, so let’s do that now.

We'll take this opportunity to add a Glossary to our project.

Click the Add Existing Documents button in the Documents pane.

GBS

ﬁ Home Topics Project
i’l 6@3 %'} éd ) Cance

Select | Build Rebuild View ¢ Build Log
Target ~ - o

[

HY

Target - Pittsburgh's 250th Anniversary MetHelp

Documents
'tl:'l j'l__;'l-I@_‘I'x S

----- o] PittsburghQuickTour.doc

The Document Import Wizard will open. Follow the same steps we used when importing PittsburghQuickTour.doc,

but this time, choose Glossary.doc from the \My Doc-To-Help Projects\Samples\Pittsburgh250WordSource\Documents
folder.

We could have imported this originally, but now you can see how easy it is to do after you have already created your
project ...
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-

.. Document Import Wizard

Doc-To-Help will import all files

Select Files or Folders to Import

and folders added below.

Add file(s)...

_ Select files for import
@Ov‘ . # Documents - |¢f| |5Eﬂr|:h ol
‘ Organize ~ 888 Views ~ [ Mew Folder
Folders v Namef Date modif.. Type ¥
@ Copyf M My Doc-To-Help Projects + | |®]Glossary.doc I
./ Pittsburgh Pittsburgh250References.doc
) Leawve )
. Samples I@]Plttsl:rl..lrghﬁl]‘l.l‘ufvzrr-dS-:rur-::e.-:i-::n.:
. EmployeeHandbook Jl I@]I:"ittsl:u..lrghQui-::th-:rur.-::Icrr.:
. MS5andcastle ‘ﬂ B pittsburghRichContentVariables.doc
. Pittsburgh250HTMLSource
- Pittsburgh250WordSource
| CS55Files
. Documents
. Media
. MNetHelp
File name: Glossary doc - [Word documents (*.doc;".doc v]
[ Open I"’] [ Cancel l

After the import is complete, the new document will appear in the Documents pane.

Documents

'8

----- @ PittsburghQuickTour.doc

£ S

Eh Documents

j_:" Contents

@ Index and Groups

Related Topics
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Since a Glossary is a special type of document in Doc-To-Help, right-click on it and choose Glossary from the menu.

Documents @t startpage x |
4 (P = X e v @ z
@ PittsburghQuickTour.doc Il-f'dlr'ft':jj'l'.’i__C' me to D
@ Glossary.doc
iw  Open with Microsoft Word
L) Convert to XHTML...
-’-'—' Expand All
3. Collapse All
ﬂ Create New Document 3
_;, Add Existing Documents
@ Convert Multiple Documents to XHTML...
=j| Rename Document
¥  Remove Document
=3 Copy Link
|Aih& Glossary M
i Properties... e

Our document is now flagged as a Glossary with a special icon.

Documents

'J'd :J {"_;'@ﬂx & ¥

4| PittsburghQuickTour.doc
Glossary.doc

b =

Double-click on Glossary.doc to open it. You'll see that two index entries are in this document: Confluence and
Primanti Brothers Sandwich. If you put your cursor in either heading, you'll notice that they are formatted with the
Glossary Heading style. This style has a special behavior in online Help Targets.

Close Glossary.doc and build your Target. You'll notice that Glossary has been added to the Table of Contents, plus the
word "confluence" is now a hyperlink. When you click on it, the glossary entry is displayed as a popup.
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Jg Pittsburgh's 250th Anniversary M- v [ g v Page~ Safety~ Tooks~ @@~

Contents || Index Senn:n- |E|EE@

|D Pittsburgh’s 250th Anniversary |
(a8 Pittsburgh Sports
: \ E r th .
[ Pittsburgh Sites Pittsburgh’s 250™ Anniversary
[ Famous Pittsburghers
O Glossary The city of Pittsburgh, Pennsylvania recently celebrated its 250th E

anniversary.

In honor of that occasion, here is a guide to what makes Pittsburgh a
great place to live, work, and visit.

The center of Pittsburgh is the often-photographed]confluence|— the spot

h the M hel d All
where the Monongahela an & Confluence W

The flowing together of two or more streams to form a third.

1

This popup is a Doc-To-Help feature — Doc-To-Help automatically creates links from topic text to identical glossary
entries — but only once in each topic. This can be turned off if you like, but it is a great way to give your readers access to
useful definitions that they might normally miss, with no extra work on your part. If you would like to create a manual
link to a glossary entry, simply create a link using the Glossary Link Type in the Link dialog box.

Note: To add a new, empty document to your project, click the Add New Document button in the Documents pane
toolbar.

Documents
: EI IE'ID'@Kl‘* ¥ & ¥
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Adding Glossary Entries

It is easy to add additional entries to your glossary — and you don't need to worry about alphabetizing them because
Doc-To-Help will do it for you.

Open Glossary.doc. It contains two entries.

Glossary

Confluence

The flowing together oftwo or more streams to form a third.

Primanti Brothers Sandwich

A sandwich inventedin Pittsburgh by the Primanti Brothers. It includes fries and cole slawright on the sandwich. See
http://primantibrothers.com/ for pictures and details |

It's easy to add more entries and alphabetize the list.
After the first two entries, add the following:

Ohio River
A river that begins in Pittsburgh and joins the mighty Mississippi in Illinois.

Now, we need to apply styles to the new entry. These styles not only control the look of the entries, but also the
behavior.

Click on Confluence, you'll notice the style is Glossary Heading. The definition is C1H Popup Topic Text. Apply
those styles to Ohio River and its definition. (Use the same method we used when we applied the C1H Bullet style

earlier.)
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It will look like this:

Glossary

Confluence

The flowing together oftwo or more streamsto form a third.

Primanti Brothers Sandwich

A sandwich inventedin Pittsburgh by the Primanti Brothers. It includes fries and cole slaw right on the sandwich. See
http:/‘primantibrothers. com’ for pictures and details.

Ohio River

A nver thatbegins in Pittsburgh andjoins the mighty Mississippi in lineis.

Ohio River is in the Glossary, but now the Glossary is not in alphabetical order. To fix that, click the Sort button in the
Doc-To-Help ribbon. The Glossary will now be alphabetized.

e

i Doc-To-Help

[E] Flash Movie & ] ﬁ
ABC ABC

5 HTML Help Control

}Margin Image - Add Sort
Mote ~ Map Editor ‘] Cross-reference = Terms
Links Glossary

Save and close Glossary.doc. Build the project.

"Ohio River" is now in the list of topics in the Topics window.
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7} Start Page /l/ﬂ Output/]/ﬁ Topics X \—-

Document Title
e
@ Documents... Pittsburgh's 250th Anniversary
@ Documents... Pittsburgh Sports
i:irl Documents... Football
@ Docurments... Baseball
@ Documents... Hockey
i:irl Documents... Pittsburgh Sites
ﬁ-ﬁDDcuments... Glossary
Confluence

Ohio River
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40 Documents...

S i
1% Documents... ;

ﬁ-ﬁ Documents..  Primanti Brothers Sandwich

Style

Heading 1
Heading 1
Heading 2
Heading 2
Heading 2
Heading 1
Heading 1
Glossary Heading
Glossary Heading
Glossary Heading

Creating a Customized Table of Contents

As you've already seen, Doc-To-Help automatically creates a Table of Contents for you based on the structure of your
documents. But you can customize your Table of Contents if you wish.

Open the Contents pane. If you select an item in the Table of Contents and click Remove Topic to remove it — or drag
a topic from the Topics window into the Contents pane to add it — the table of contents will be flagged as
Customized. Changing the name of an item in the TOC (using the Rename button) will also customize it.

Contents ICustumized |
R ﬁ@}g.&@

i g] Pittsburgh's 250th Anniversary
=AU Pittsburgh Sports
@ Football
ﬂ Basehall
_ Q Hockey
. ﬂ Pittsburgh Sites

oE=m

If you would like this table of contents to be exclusively used for the Target selected, click the Target-Specific Table of

Contents button.

Contents Customized

o g] Pittsburgh's 250th Anniversary

If you decide that you would prefer to return to the original table of contents (based on the document structure) click the

Rebuild Table of Contents button.

Contents Customized

------ & Pittsburgh's 250th Anniversary
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Adding Items to the Index and Creating Groups

There is already one item in our index, which we added directly from one of our documents. We can also add items using
the Index and Groups pane, along with the Topics window.

Click on the Index and Groups pane, and click the Keyword button.

W g9 ™ Jﬁ 4 = ComponentOne Doc-To-Help - Pittsburgh.d2h = CT R X
liﬂ Home Topics Project Lp @
T l_# B | Ii] Platforms: M Related Links Label: ; ."ﬁr"

& of W W) e e k |
Printand Filter | Contents Index Related | = BrgeEts ore Properties | Open
Export ~ View - Topics Attributes: = || [ Hide subtopic links

View | Condition | Related Topics | Properties | Editor |

/@} Start Page
|T'rl|e |.‘iyle
e

Keywords
E 202 g % =X

-~ Monongahela

5

Pittsburgh's 250th Anniversary Heading 1
Pittsburgh Sports Heading 1
Football Heading 2

Baseball Heading 2
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Monongahela: One Topic Indexed

HEEDE D ® 5
g
:

: - - Hockey Heading 2 Documen
iy Pittsburgh's 250th Anniversary (PittsburghQ
Pittsburgh Sites Heading 1 Documen
Glossary Heading 1 Documen
Confluence Glossary Heading Documen
Primarti Brothers Sandwich Glossary Heading Documen

Click the Add New Keyword button.

Keywords
..... ]3 m |
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Name the keyword "sightseeing." Then select the topic "Pittsburgh Sites" from the Topics window and drag it into the
lower Keywords pane. You can link multiple topics to a single keyword; just drag them into the lower pane also.

D éaEg9 el s ComponentOne Doc-To-Help - Pittsburgh.d2h o B e
Iiﬂ Home Topics Project sk @
T l*‘_ Iﬁ] Platforms: | Related Links Label: ;‘ ."T?
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Pittsburgh Sports Heading 1 Documen
Football Heading 2 Documen
Baseball Heading 2 Documen
. sightseeing: One Topic Indexed )
: : - - Hockey Heading 2 Documen
B Pittsburgh Sites (PittsburghQuickTour.doc) 7 h
EF"rt'tsburgh Sites EIHeading 1 Docurmen
Glossary Heading 1 Ef Documen
Confluence Glossary Heading E‘f Documen
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ED Documents
j_jl Contents
@ Index and Groups
"y .
Related Topics 4 m C
Ready [z

You can create topic Groups using this same pane. Topic groups are collections of topics you can create links to. When
the user clicks the link, the topics in the group will display in a popup window or dialog box.

First, click the Groups button in the Index and Groups pane.

Groups

il [3 |4

|ID Documents

j_jl Contents

m Index and Groups

Getting Started Workbook

Doc-To-Help Quick Tour e 43



Click the Add Group button and name the new group "Sports."

Groups

HE [E ERS

...... =
Select the topics "Football”, "Baseball", and "Hockey" in the Topics window and drag them into the lower Groups
pane.
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Pittsburgh Sites
Glossary
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Ohio River

Primanti Brothers Sandwich

L

These topics are now a group hamed "Sports" and you can create a link to them using the Link dialog box.

Open PittsburghQuickTour.doc and in the "Pittsburgh Sports" topic, select the word "sports."

Click the Link button on the Doc-To-Help ribbon tab and choose Group from the Link type drop-down. Select the

Sports check box and click OK.
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Pittsburgh Sportsq]

Pittsburgh is well-known forits pmfes.sinnae ams, and hasbeen hailed asthe “City of Champions™ because two
teams (the Steelers and Pirates) won their league’s world championships n the same year(1979). The Pittsburgh
Penguns have & ] i

_ Link ==
] F'U'Utba Teut: sports

The six time 81| |Link type: [{Z Group ~ =
The Steelers wq Target fle
Lo
team. Group: Sports
Steeler fans — § le
Towel, thelate Groups
Leammoreabd | [ 4[5 Sports
- Link options
Baseba
Topic list in: (Default) -
MajorLeague B Park,
located onthe b Window: (Default) -
Leammore abg

Options

- | Hide properties in document
Hockey

Show as button

The Pittsburgh they
defeatedthe De ers in
the NHL, Sidne @ Help OK l | Cancel

Mano Lermeux

Mellon Arena, t - — = T T

Leammore about the Penguins at http//werw. pittsburshp ensuins com/

Save and close your document. Build your Target.

Now, "sports" is a hyperlink, and when you click on it, a menu with all of the topics in that group displays. Select any
one of the menu items, and the topic opens.
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More:
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We hope you enjoyed the Doc-To-Help Quick Tour! Feel free to use this project to test-drive Doc-To-Help further.

Additional Resources

The schedule of free Doc-To-Help introductory webcasts can be found at:
http://www.doctohelp.com/SuperPages/Webcasts/.

Information about training classes and self-paced training manuals is available here:
http://www.doctohelp.com/SuperProducts/DocumentationSupport/Training+/.

Sample Doc-To-Help projects can be found in the following location. These projects demonstrate Doc-To-Help features
and functionality. There are projects that feature each type of document editor, software documentation, Sandcastle
reference documentation, an Employee manual, mobile help, and a sample in German.

e Windows® 7 and Vista: \\Users\<username>\Documents\My Doc-To-Help Projects\Samples
e Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects\Samples

Also see the PDF quick reference guides available on the Start Page of Doc-To-Help, and the Help menu (available
from the File tab.)
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